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1. Introduction 
 

1.1 Additional Module STEEL AISC 

The U.S. Specification for Structural Steel Buildings (ANSI/AISC 360-05) determines rules for 
the design, analysis and construction of steel buildings in the United States of America. 
With the add-on module STEEL AISC from the company DLUBAL ENGINEERING SOFTWARE all users 
obtain a highly efficient and universal tool to design steel structures according to this stan-
dard. 

All typical designs of load capacity, stability and deformation are carried out in the module 
STEEL AISC. Different actions are taken into account during the load capacity design. The al-
location of designed cross-sections into three types (compact, noncompact and slender) 
makes an important part of the design according to the Specification mentioned above. The 
purpose of this classification is to determine the range in which the local buckling in cross-
section parts limits the load capacity so that the rotational capacity of cross-sections can be 
verified. Further, STEEL AISC automatically calculates the limiting width-to-thickness ratios 
of compressed parts and carries out the classification automatically. 

For the stability design, you can determine for every single member or set of members 
whether buckling is possible in the direction of y-axis and/or z-axis. Lateral supports can be 
added for a realistic representation of the structural model. All comparative slendernesses 
and critical stresses are automatically determined by STEEL AISC on the basis of the boun-
dary conditions. For the design of lateral torsional buckling, the elastic critical moment that 
is necessary for the design can be either calculated automatically or entered manually. The 
location where the loads are applied, which influences the elastic critical moment, can also 
be defined in the detailed settings.  

The serviceability limit state has become important for the static calculations of modern civil 
engineering as more and more slender cross-sections are being used. In STEEL AISC, load 
cases and groups and combinations of load cases can be arranged individually to cover the 
various design situations. 

Like other modules, STEEL AISC is fully integrated into the RSTAB 7 program. However, it is 
not only an optical part of the program. The results of the module can be incorporated to 
the central printout report. Therefore, the entire design can be easily and especially uni-
formly organized and presented. 

The program includes an automatic cross-section optimization and a possibility to export all 
modified profiles to RSTAB. 

Individual design cases make it possible to flexibly analyze separate parts of extensive struc-
tures. 

 

We wish you much success and delight when working with our module STEEL AISC. 

Your DLUBAL ENGINEERING SOFTWARE company. 
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1.2 STEEL AISC Team 
The following people participated in the development of the STEEL AISC module: 

Program Coordinators 
Dipl.-Ing. Georg Dlubal 
Dipl.-Ing. (FH) Younes El Frem 

Ing. Ph.D. Peter Chromiak 

Programmers 
Ing. Zdeněk Kosáček 
Ing. Ph.D. Peter Chromiak 
Dipl.-Ing. Georg Dlubal 
Dr.-Ing. Jaroslav Lain 
Ing. Martin Budáč  
Mgr. Petr Oulehle 

Ing. Roman Svoboda 
David Schweiner 
Ing. Tomáš Jelínek 
Ing. Zbyněk Zámečník  
DiS. Jiří Šmerák 

Library of Cross-Sections and Materials 
Ing. Ph.D. Jan Rybín 
Stanislav Krytinář 

Jan Brnušák 
 

Design of Program, Dialog Boxes and Icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Testing and Technical Support 
Ing. Martin Vasek 
Ing. Ph.D. Peter Chromiak 
Ing. Ph.D. Jaromír Křížek 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Matthias Entenmann  
Dipl.-Ing. Frank Faulstich 

M. Sc. Dipl.-Ing. (FH) Frank Lobisch 
Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Walter Rustler 
M. Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Robert Vogl 

Manuals, Documentation and Translations 
Ing. Ph.D. Peter Chromiak 
Dipl.-Ing. (FH) Robert Vogl 
Mgr. Petra Pokorná 
Ing. Petr Míchal 

Ing. Ladislav Kábrt 
Dipl.-Ü. Gundel Pietzcker 
Ing. Dmitry Bystrov 
Mgr. Michaela Kryšková 

1.3 Using the Manual 
All general topics such as installation, user interface, results evaluation and printout report 
are described in detail in the manual for the main program RSTAB. Hence, we omit them in 
this manual and will focus on typical features of the add-on module STEEL AISC. 

During the description of STEEL AISC, we use the sequence and structure of the different 
input and output tables. We feature the described icons (buttons) in square brackets, e.g. 
[Details]. The buttons are simultaneously displayed on the left margin. The names of dialog 
boxes, tables and particular menus are marked in italics in the text so that they can be easily 
found in the program. 

The index at the end of this manual enables you to quickly look up specific terms. 
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1.4 Starting STEEL AISC 
It is possible to initialize the add-on module STEEL AISC in several ways. 

Main Menu 
You can call up STEEL AISC by the command from the main menu of the RSTAB program: 

Add-on Modules → Design - Steel → STEEL AISC. 

 
Figure 1.1: Main Menu: Additional Modules → Design - Steel → STEEL AISC 

Navigator 
Further, it is possible to start STEEL AISC from the Data navigator by clicking on the item 

Add-on Modules → STEEL AISC. 

 
Figure 1.2: Data Navigator: Additional Modules → STEEL AISC 
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Panel 
If results of STEEL AISC are already available in the RSTAB position, you can set the relevant 
design case of this module in the list of load cases in the menu bar. The design criterion on 
members is displayed graphically in the work window of RSTAB by using the [Results on/off] 
button. 

The [STEEL AISC] button that enables you to start STEEL AISC is now available in the panel. 

        
Figure 1.3: [STEEL AISC] Button in Panel 
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2. Input Data 
The data of the design cases is entered in different tables of this module. Furthermore, the 
graphic input using the function [Pick] is available for members and sets of members. 

After the initialization of the STEEL AISC module, a new window is displayed. In its left part, 
a navigator is shown that enables you to access all existing tables. The roll-out list of all 
possibly entered design cases is located above this navigator (see chapter 7.1, page 46). 

If STEEL AISC is called up for the first time in a position of RSTAB, the following important 
data is loaded automatically:  

• Members and sets of members 
• Load cases, load groups and combinations 
• Materials 
• Cross-sections 
• Internal forces (in the background – if calculated) 

You can switch among the tables either by clicking on the individual navigator items of 
STEEL AISC or by using the buttons visible on the left. The [F2] and [F3] function keys can 
also be used to browse the tables in both directions. 

Save entered data by the [OK] button and close the module STEEL AISC, while by the [Can-
cel] button you terminate the module without saving data. 

2.1 General Data 
In the table 1.1 General Data, members, sets of members and actions are selected for the 
design. You can specify load cases, load groups and combinations for the ultimate limit 
state and the serviceability limit state design separately in the corresponding tabs.  

2.1.1 Ultimate Limit State 

 
Figure 2.1: Table 1.1 General Data, Ultimate Limit State tab 
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Design of 
You can select both Members and Sets of Members for the design. If only specific objects 
are to be designed, it is necessary to clear the check box All. By doing so, both input boxes 
become accessible and you can enter the numbers of the relevant members or sets of mem-
bers there. With the [Pick] button, you can also select members or sets of members graphi-
cally in the RSTAB work window. To rewrite the list of default member numbers, select it by 
double-clicking it, and then enter the relevant numbers. 

If no sets of members have been defined in RSTAB yet, they can be created in STEEL AISC via 
the [New Set of Members…] button. The familiar RSTAB dialog box to create a new set of 
members opens in which you enter the relevant data. 

Designing sets of members has the advantage that selected members can be analyzed to 
determine the total maxima of the design ratios. In this case, the results tables 2.3 Design 
by Set of Members and 4.2 Parts List by Set of Members are displayed additionally. 

Design according to 
The list box controls whether the analysis is carried out according to the provisions of the 
Allowable Strength Design (ASD) or the Load and Resistance Factor Design (LRFD). 

Existing Load Cases / Load Groups and Load Combinations 
All design-relevant load cases, load groups and load combinations that were created in 
RSTAB are listed in these two sections. The [] button moves the selected load cases, load 
groups or combinations to the list Selected for Design on the right. Specific items can also 
be selected by double-clicks. The [] button transfers all items to the list on the right. 

If an asterisk (*) is displayed at load cases or combinations, as you can see e.g. in Figure 2.1 
at load cases 8 to 10, they are excluded from the design. It signifies that no loads were as-
signed to these load cases or that they contain only imperfections (as in our example). 

Furthermore, it is only possible to select load combinations for which the minimum and 
maximum values can be determined unambiguously. This restriction is necessary because 
the calculation of the elastic critical moment at lateral buckling requires the unambiguous 
assignment of moment diagrams. If an invalid load combination is selected, the following 
warning appears:  

 
Figure 2.2: Warning when Selecting Invalid LC, LG or CO  

A multiple choice of load cases can be done by using the [Ctrl] key, as a routine procedure 
in Windows. Hence, you can select and transfer several load cases to the list on the right 
simultaneously. 

Selected for Design 
The loads selected for the design are listed in the right column. By the [] button you can 
remove the selected load cases, load groups or load combinations from the list. As before, 
the selection can be executed by double-clicks. The [] button removes all items from the 
list. 
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Generally, the calculation of an enveloping Or load combination is faster than the analysis 
of all contained load cases or groups. On the other hand, you must keep in mind the above-
mentioned restriction: to determine the maximum or minimum values unambiguously, the 
Or load combination must only contain load cases, groups or combinations which enter the 
combination with the criterion Constant. Moreover, the design of an enveloping load com-
bination makes it a bit difficult to retrace the influence of the contained actions. 

2.1.2 Serviceability Limit State 

 
Figure 2.3: Table 1.1 General Data, Serviceability Limit State tab 

Existing Load Cases / Load Groups and Load Combinations 
All load cases, load groups and load combinations that were created in RSTAB are listed in 
these two sections. 

Selected for Design 
Adding load cases and their groups and combinations to the list for the design, resp. re-
moving them from the list is done in the same way like in the previous register tab (see 
Chapter 2.1.1). 
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2.2 Materials 
This table is divided into two parts. The materials for the design are listed in the upper part. 
In the lower part, the Material Properties of the current material are displayed, i.e. the ma-
terial whose line is selected in the upper table. 

The material properties that are necessary to calculate the internal forces in RSTAB are de-
scribed in detail in the RSTAB manual, Chapter 5.2. The design-relevant material characteris-
tics are stored in the global material library. Those are automatically set as default.  

The units and decimal places of the material properties and stresses can be edited from the 
main menu Options → Units and Decimal Places… (see Chapter 7.4, page 51). 

 
Figure 2.4: Table 1.2 Materials 

Material Description 
The materials that have been defined in RSTAB are set by default. You can also enter mate-
rials manually here. If the Material Description corresponds to an entry in the material li-
brary, STEEL AISC automatically imports the relevant material properties. 

To select a material from the list, place the cursor in column A and click on the [] button 
or press the [F7] function key. A list is opened that you can see on the left. As soon as you 
have chosen the appropriate material, the material characteristics are updated in the table 
below.  

The list of materials includes only materials from the category Steel. How to import mate-
rials from the library is described below. 

Import Material from Library 
A considerable amount of materials is stored in the library. Open the library via menu 

Edit → Material Library… 

or by clicking on the button visible on the left. 
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Figure 2.5: Material Library Dialog Box 

In the section Filter Choice, the material category Steel is set by default. In the list Material 
to Select which is located on the right, you can select a particular material, and in the lower 
part of the dialog box you can check its characteristic values. After clicking on [OK] or press-
ing the [↵] key, the material is taken over to the table 1.2 Materials of STEEL AISC. 

Chapter 5.2 of the RSTAB manual explains in detail how materials can be filtered, added to 
the library or newly classified. 

Basically, you can also select materials of the categories Cast Iron and Stainless Steel of the 
library. However, you have to bear in mind that those materials are not thoroughly covered 
by the ANSI/AISC 360-05 standard. For this reason, it is not possible to significantly modify 
the material properties in STEEL AISC.  
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2.3 Cross-Sections 
This table controls the cross-sections that are to be designed. The parameters of the optimi-
zation can be defined here as well. 

Coordinate System 

The sectional coordinate system yz of STEEL AISC corresponds to the one of RSTAB (see im-
age in Figure 2.6). The y-axis is the major principal axis of the cross-section, the z-axis the 
minor axis. This coordinate system is used for both the input data and the results. 

 
Figure 2.6: Table 1.3 Cross-Sections 

Cross-Section Description 
When you open this table, the sections that were defined in RSTAB are set by default, in-
cluding the assigned material numbers. 

The cross-sections can be changed any time for the design. The description of a modified 
cross-section is highlighted in blue color. 

In order to edit a cross-section, enter the new description in the corresponding line or select 
the new section from the library. Open the library by clicking on the [Import Cross-Section 
from Library…] button. Alternatively, place the cursor in the corresponding line and click on 
the [...] button or press the [F7] key. The library opens which is already familiar from RSTAB, 
see Figure 2.7. 

Chapter 5.3 of the RSTAB manual describes in detail how cross-sections can be selected 
from the library. 

If the cross-sections are different in STEEL AISC and RSTAB, both cross-sections are shown in 
the graphic window next to the table. The internal forces from RSTAB are then used for the 
stress design of the cross-section that is set in STEEL AISC. 
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Figure 2.7: Cross-Section Library 

HSS cross-sections can only be designed if the thicknesses of web and flanges are the same. 
If they are different, footnote 1004) Non-permissible cross-section type of ‘Rectangular HSS’ 
is shown. 

Tapered Member 
In case of a tapered member with different cross-sections at the member start and member 
end, both cross-section numbers are stated in two lines, following the definition in RSTAB. 
You can design tapered members in STEEL AISC if the following condition is fulfilled: an 
equal number of stress points is required at both member ends. 

For example, the normal stresses are calculated from the moments of inertia and from the 
centroidal distances of the stress points. If the start and end cross-sections of the tapered 
member have different numbers of stress points, STEEL AISC cannot interpolate the inter-
mediate values. An error message appears before the calculation: 

 
Figure 2.8: Warning in Case of Incompatible Cross-Sections  

To check on the stress points of the cross-section, you can display them including their 
numbers: Select the cross-section in the table 1.3 and click on the [Info about Cross-
Section…] button. 
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Info about Cross-Section 
There are different display options for stress points and c/t cross-section parts in this dialog 
box. 

 
Figure 2.9: Info about Cross-Section Dialog Box 

The currently selected cross-section is displayed in the right part of the dialog box. The vari-
ous buttons below have the following functions: 

 

 
Table 2.1:  Buttons for Cross-Section Graphics  

Button Function 

 The stress points are switched on and off. 

 The cross-section parts (c/t) are switched on and off.  

 The numbering of stress points, resp. of cross-section parts (c/t) is switched 
on and off. 

 The details of stress points, resp. of cross-section parts (c/t) are displayed. 

 The dimensioning of the cross-section is switched on and off. 

 The principal axes of the cross-section are switched on and off. 
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Cross-Section Type for Classification 
In this column, the various cross-section types are listed which are applied for the design 
(e.g. I-shape rolled or welded, box, round bar etc.) 

 
Figure 2.10: Cross-section Types for Classification 

Max. Design Ratio 
Due to this column, you can decide whether to carry out an optimization. This column is 
only displayed after STEEL AISC has designed the cross-sections. It becomes visible from the 
data and the colored relation scales in this column which cross-sections have a low design 
ratio and therefore are oversized, resp. which are overstrained and therefore are too weak. 

Optimize 
Every cross-section can be optimized. During the optimization process, the cross-section 
within the same group of cross-sections is determined on the basis of the internal forces 
from RSTAB which fulfills best the maximum design ratio. Figure 2.6 shows how the optimi-
zation of a particular cross-section is set by ticking the corresponding box in column D. 

The maximum allowable design ratio for the optimization is controlled in the Details dialog 
box, see chapter 3.1. Further information on the optimization of cross-sections can be 
found in chapter 7.2 on page 48. 

Remark 
In this column, the references to footnotes (below the list of cross-sections) are shown.  

If the message Non-permissible Cross-Section No. XX appears before the design, then this is 
due to a cross-section which is not contained in the cross-section library. It may be a user-
defined cross-section or a cross-section that was not calculated in the module SHAPE-THIN. 
Via the [...] button in column B Cross-section Description, you can set a cross-section that is 
suitable for the design (see Figure 2.7 with following remarks). 
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2.4 Lateral Intermediate Supports 
In this table, lateral intermediate supports on members can be defined. The program always 
assumes these supports as perpendicular to the minor axis z (see Figure 2.6) of the cross-
section. Hence, it is possible to change the effective lengths of the member that are impor-
tant for the design of column buckling and lateral torsional buckling. It is also important to 
know that lateral intermediate supports are considered as forked supports for the design. 

 
Figure 2.11: Table 1.4 Lateral Intermediate Supports 

In the upper part of this table, up to nine lateral intermediate supports can be created per 
member. The lower part of the table displays the summary of the entered data for every 
single member. 

Lateral intermediate supports can be defined either by directly entering the distances or by 
specifying the support locations Relatively. For the latter, it is necessary to tick the asso-
ciated check box below the list. The relative distances of the supports are then calculated 
from the member lengths. 

You have to be very careful if the model contains cantilever beams. Intermediate supports 
divide the member into several parts for the design. Therefore, intermediate supports are to 
be avoided for cantilever beams because they would imply statically underdetermined piec-
es with fork-type supports on only one side each. 
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2.5 Effective Lengths - Members 
The table 1.5 consists of two parts so that a good overview of the data is provided. In the 
upper table, the effective length factors Ky and Kz, the effective lengths Ky L and Kz L, the 
Torsional Buckling effective length factors Kx and the effective lengths Kx L for torsional 
buckling are summarized for every member. In the lower part of this table, detailed infor-
mation on the member that is selected in the upper table is displayed. The lower table con-
tains all information about the relevant lengths of this member. 

 
Figure 2.12: Table 1.5 Effective Lengths - Members 

The effective lengths for the column buckling about the minor principal axis and the effec-
tive lengths for torsional buckling are automatically loaded from the previous table 1.4. If a 
member is divided into different lengths by lateral intermediate supports, then no values 
are displayed in the corresponding columns G and J of table 1.5. It is possible to change the 
buckling length coefficients both in the summary table in the upper part and in the detailed 
settings in the lower part. The data of the corresponding part of this table is then updated 
automatically. The buckling length of a member can also be defined graphically by using 
the function [Pick]. 

The tree structure in the lower part of the Settings for Member table contains the following 
parameters: 

• Cross-section 

• Length (actual length of the member) 

• Buckling Possible (cf column A)  

• Buckling around Axis y (buckling lengths, cf columns B - D) 

• Buckling around Axis z (buckling lengths, cf columns E - G) 

• Torsional buckling (buckling lengths, cf columns H - J) 

• Lateral-torsional Buckling Possible (cf column K) 

It is also possible to modify the Buckling Length Coefficients in the relevant directions and 
decide whether the buckling design is to be executed. If a buckling length coefficient is 
changed, the respective effective member length is modified automatically. 
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The effective length factors of the members can also be defined in a special dialog box 
which is called by the button [Select Effective Length Factor…] below the upper table.  

 
Figure 2.13: Dialog box: Select Effective Length Factor 

The Theoretical or Recommended values of the K factor that are to be assigned to the se-
lected member or group of members can be defined in this dialog box. The theoretical and 
the recommended values are described in [2] on page 240. Generally, it is possible to select 
predefined K factors or to enter User-defined values. 

The effective lengths for buckling can also be imported from the add-on module RS-BUCK.  

Buckling Possible 
For the stability design of the buckling and lateral buckling, it is necessary for the member 
to transfer compression forces. Members that cannot transfer compression forces due to 
their definition (e.g. tension members, elastic foundations, rigid couplings) are a priori ex-
cluded from the stability design in STEEL AISC. In such a case, a corresponding comment is 
displayed in the column Comment for this member. 

The column Buckling Possible enables you to classify specific members as compression ones 
or, alternatively, to exclude them from the design according to Chapter E. Hence, the check 
boxes in column A and also in table Settings for Member No. control whether the input op-
tions for the buckling length parameters are accessible for a member.  

Length 
For your information, the actual length of the selected member is displayed in the lower ta-
ble. It is not possible to modify this value. 

Buckling around Axis y resp. Axis z 
The columns Buckling Possible control members are prone to buckling around their axes y 
and/or axes z. The axis y represents the "major" principal member axis, the axis z the "minor" 
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principal member axis. The buckling length factors Ky and Kz can be freely chosen for the 
buckling around the major and minor axes. 

The orientation of the member axes can be checked in the cross-section graphics of this ta-
ble. In the RSTAB work window which can be opened any time via the [Graphic] button, 
you can display the local member axes from the Display navigator. 

 
Figure 2.14: Displaying the Local Member Axes in the Display Navigator of RSTAB 

If buckling is possible around one or both member axes, the precise values can be entered 
in columns D and E respectively F and G or in table Settings for Member No. below. 

If you define the buckling length coefficient K, the buckling length KL is determined by mul-
tiplying the member length L with this buckling length coefficient.  

Via the [...] button at the end of the KL input fields, you can select two nodes in the RSTAB 
work window graphically. Their distance then defines the buckling length. 

Torsional Buckling 
Column H controls whether a torsional buckling design is to be performed. The effective 
length factors Kx and the torsional buckling lengths KxL can be defined in columns I and J. 
The axis x represents the centre line of a member. 

 
Figure 2.15: Member Axes 
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Lateral-Torsional Buckling L.T.B. 
Column K controls whether a lateral torsional buckling design is to be carried out. The lat-
eral-torsional buckling lengths depend on the settings of table 1.4 Lateral Intermediate 
Supports. There is no possibility to insert a user-defined value here. 

The modification factor Cb for lateral-torsional buckling can be defined in table 1.7 Design 
Parameters (see Chapter 2.7).  

Comment 
In the last column the user can write down his own remarks at every member, e.g. to ex-
plain more closely the specific lengths of a member. 

The check box Set Inputs for Members No. is located beneath the tree-structure lower table. 
If you tick this box, the data entered consequently

2.6 Effective Lengths - Sets of Members 

 will become valid for specific resp. All 
members. You can select the members graphically by using the function [Pick] or enter their 
numbers manually. This option is useful when you want to assign the same boundary con-
ditions to several members. Please notice that this function must be activated prior to data 
entering. If you define the data and choose this option later, the data is not re-assigned. 

The input table 1.6 controls the effective lengths for sets of members. It is only available if 
one or more sets of members have been selected in table 1.1 General Data. 

 
Figure 2.16: Table 1.6 Effective Lengths - Set of Members 

This table is very similar to the previous table 1.5. With regard to the effective lengths for 
buckling around the major and minor axes of the cross-sections, it is identical to table 1.5. 

There are differences, however, as far as the parameters for torsional and lateral-torsional 
buckling are concerned. These are defined by means of specific boundary conditions in ta-
ble 1.8 and 1.9 (see Chapters 2.8 and 2.9). 
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2.7 Design Parameters  
In this table, several parameters can be defined that are necessary for design. 

 
Figure 2.17: Table 1.7 Design Parameters 

Modification Factor 
In column A, there is the possibility to choose among the three options of the lateral-tor-
sional buckling modification factor Cb. The default value is set to 1.0. The Cb factor can also 
be entered manually or determined by the program according to Equation F1-1 [1].  

Distance Lv 
The distance Lv specifies the distance between the points of maximum and zero shear force 
according to the Section G6 [1]. This applies to round HSS members. 

Gross Area Ag / Net Area An 
In the columns C and D, the gross and net areas of all members are listed. If required, the 
net area can be modified in order to consider holes. 

Shear Lag Factor U 
For every member, the shear lag factor for tension design can be defined according to 
Table D3.1 [1]. 

Effective Area Ae 
Column F lists the effective areas of the members which are determined according to 
Equation D3-1 [1] from the net areas and the shear lag factors. 
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2.8 Nodal Supports - Sets of Members 
The stability design of sets of members is carried out according to Chapter C of the ANSI/ 
AISC Specification [1]. According to Chapter H of this standard, you can design doubly 
symmetrical, singly symmetrical and unsymmetrical cross-sections stressed by compression 
and/or bending in a plane. The value of the multiplier αcr has to be determined for the en-
tire set of members in order to obtain the critical moment Mcr which is necessary for the de-
sign. The calculation of αcr, the bifurcation factor, also depends on the setting in the Details 
dialog box (see Chapter 3.1, page 27). 

To determine αcr, a planar member structure with four degrees of freedom per node is 
created. The specific support conditions are defined in table 1.8. This table is only available 
if you have selected one or more sets of member in table 1.1 General Data. 

 
Figure 2.18: Table 1.8 Nodal Supports - Set of Members 

To define the nodal supports, the orientation of the axes within a set of members is impor-
tant. The program internally checks the location of the relevant nodes and then determines 
the axis system for the nodal supports that are to be defined in table 1.8 (see Figure 2.19 to 
Figure 2.22). 

 
Figure 2.19: Auxiliary Coordinate System for Nodal Supports of Sets of Members 

If all members within the set of members lie on a straight line, the local coordinate system 
of the first member within this set is applied for the entire set of members. 
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Figure 2.20: Auxiliary Coordinate System for Nodal Supports of Set of Members  

Even if the members within a set do not lie on a straight line, they still must lie in a plane. 
We can see a vertical plane in Figure 2.20. In this case, the axis X’ is horizontal and in the 
plane direction. The axis Y’ is also horizontal, but perpendicular to the axis X’. The axis Z’ 
points vertically downwards. 

 
Figure 2.21: Auxiliary Coordinate System for Nodal Supports of Set of Members  

If the members are located in a horizontal plane, the axis X’ is parallel with the axis X of the 
global coordinate system. The axis Y’ then points in the opposite direction of the global axis 
Z. The axis Z’ is parallel with the axis Y of the global coordinate system. 

 
Figure 2.22: Auxiliary Coordinate System for Nodal Supports of Set of Members 

Figure 2.22 shows the most general case. The members within a set of members do not lie 
on a straight line but are located in one oblique plane. The orientation of the axis X’ is then 
determined by the intersection between the oblique and the horizontal plane. The axis Y’ is 
perpendicular to the axis X’ and is also perpendicular to the oblique plane. The axis Z’ is 
perpendicular to the axes X’ and Y’. 
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2.9 Member Releases - Sets of Members 
This table is only available if one or more sets of members have been selected in table 1.1 
General Data. If any member in a given set is not able to transfer internal forces correspond-
ing to the degrees of freedom restricted in table 1.8, then nodal releases can be inserted to 
a set of members in table 1.9. There is also the possibility to exactly define on which side 
the release is to act or to place a release at both sides. 

 
Figure 2.23: Table 1.9 Member Releases - Set of Members 
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2.10 Serviceability Data 
The final input table includes different possibilities for the serviceability design. It is only 
displayed if the serviceability limit state design has been selected in table 1.1 General Data 
(cf Figure 2.3, page 10). 

 
Figure 2.24: Table 1.10 Serviceability Data 

In column A, you can refer the deformation to individual members, list of members or sets 
of members. In column B, the relevant members or sets of members can be selected graphi-
cally by using the function [Pick]. The reference lengths l in column D are then filled auto-
matically. The Reference Length is set as the length of the member or the entire length of 
the set of members resp. list of members. It can be changed Manually by using the corres-
ponding check box in column C and setting the value in column D. 

In column E, you specify the governing Direction for the serviceability design. Column F 
controls whether Camber ∆camb is to be taken into account as well. 

For a correct determination of the serviceability limit states, the Beam Type (beam or canti-
lever) is very important. It can be entered in column G. 
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3. Calculation 
 

3.1 Details 
A particular design is carried out with the internal forces calculated in the RSTAB program. 
Before the [Calculation], you should check the detailed setting for the design. Open the ap-
propriate dialog box from every input or output table by clicking on the [Details…] button.   

 
Figure 3.1: Details Dialog box 

Check of Maximum Effective Slenderness Ratio 
For members designed according to Chapter D [1], the slenderness ratio preferably should 
not exceed 300. This does not apply to the member types "Tension" and "Cable" because 
they are excluded from this check. For members designed according to Chapter E [1], the 
slenderness ratio preferably should not exceed 200. This value is applicable to all members 
with compression or flexure. 

It is possible to set user-defined slenderness ratios for members with tension resp.  compres-
sion or flexure. These maximum values are compared with the actual member slendernesses 
in table 3.3 which is available after the calculation (see Chapter 4.8). 

Serviceability (Deflections) 
In this section, it is possible to change set the allowable deflection for the serviceability limit 
state design if the default value L/360 is not appropriate. 

The two selection fields below control whether the Deformation is to be related to the un-
deformed model or to an imaginary connecting line between the shifted start and end 
nodes of the member resp. set of members within the deformed structure. 
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Determination of Elastic Critical Moment for LTB 
The elastic critical moment Mcr for set of members

Usually, loads act on members. Then their application point has to be specified because this 
can have stabilizing or destabilizing effects, subject to the eccentricity. The Point of Applied 
Load can be set globally for all loads. 

 is calculated automatically. 

Limit Load for Special Cases 
It is possible to neglect small stresses due to bending, tension or compression, shear and 
torsion and, thus, allow a simplified design which eliminates negligible internal forces. In 
this section, the limits of these internal forces or stresses can be entered. Those are defined 
as the ratios between existing internal forces or stresses and the corresponding resistances 
of each cross-section. 

Cross-section Optimization 
Cross-sections can be optimized if the Optimize option is chosen in table 1.3 Cross-Sections. 
(see Figure 2.6, page 13). The dialog box Details enables you to set the maximum allowable 
design ratio as a limit for the optimization process. 

Display Results Tables 
In this section, the results tables can be specified which are to be displayed, inclusive of a 
parts list. The results tables are described individually in Chapter 4. 

Design Wall Thickness of HSS 
The design wall thickness shall be taken equal to 0.93 times the nominal wall thickness for 
Hollow Structural Sections if the check is set here. This reduction is recommended for elec-
tric-resistance-welded HSS, not for submerged-arc-welded HSS. 

3.2 Start Calculation  
In all input tables of STEEL AISC, you can start the design via the [Calculation] button. 

At first, STEEL AISC searches for the results of the selected load cases, groups and combina-
tions of load cases. If they are not found, the calculation of the governing internal forces in 
RSTAB is started. The calculation parameters of RSTAB are used for this analysis. 

If cross-sections should be optimized (see Chapter 7.2, page 48), the required sections are 
calculated and relevant designs are carried out. 

The STEEL AISC design can be also started from the RSTAB interface. All design cases of the 
add-on modules are displayed in the To Calculate dialog box, similarly to load cases or load 
groups. Open this dialog box in RSTAB via the main menu 

Calculate → To Calculate… 
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Figure 3.2: To Calculate Dialog box 

If the design cases of STEEL AISC are missing in the list Not Calculated, it is necessary to tick 
the check box Show Additional Modules. 

The [] button transfers selected design cases to the list on the right. You can then start the 
calculation by the [Calculate] button. 

The calculation of a specific STEEL AISC design case can also be directly started from the 
toolbar. Set the required design case in the list and then click on the [Results on/off] button. 

 
Figure 3.3: Direct Calculation of Design Case from STEEL AISC in RSTAB 

A dialog box appears in which you can watch the progress of the design. 

 
Figure 3.4: Calculation in STEEL AISC
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4. Results 
 

4.1 Design by Load Case 
Table 2.1 Design by Load Case is displayed immediately after the design. In the upper part 
of this table, a summary of all designs for every load case, load group and combination is 
displayed. The lower part includes all details of the material properties, design internal 
forces and design data of the load case which is selected in the upper part of the table.  

The results tables 2.1 to 2.5 contain the detailed design summaries according to different 
selection criteria. Tables 3.1 and 3.2 include the governing internal forces. In table 3.3, the 
member slendernesses are compared with the maximum values as set in the Details dialog 
box (see Chapter 3.1). The parts lists are displayed in the last two tables 4.1 and 4.2.  

The results tables are accessible from the navigator in STEEL AISC. You can also switch 
among the tables via the buttons as seen to the left or the functional keys [F2] and [F3]. 

Save the results by the [OK] button and close STEEL AISC. 

In this chapter, we describe the particular tables in the given order. The following chapter 5 
Evaluation of Results is devoted to the evaluation and checking of results. 

 
Figure 4.1: Table 2.1 Design by Load Case 

Description 
The load cases, load groups and combinations that are decisive for every relevant type of 
design are displayed in this column. 

Member No. 
The number of the member with the highest design ratio is stated for every designed load 
case, load group or load combination. 
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Location x 
The location x on the member where the maximum stress ratio occurs is displayed in this 
column. The following locations x on the member are taken into account:  

• Start and end nodes 

• Internal nodes according to a potential user-defined member division 

• Extreme values of internal forces 

Design Ratio 
For every design type and for every load case, load group or load combination, the design 
quotients according to the standard are displayed in this column. 

Design according to Formula 
In this column, the equations that were followed in the design are displayed. 

DS 
The Design Situation which is relevant for the design is stated in this column: ULS (Ultimate 
Limit State) or SLS (Serviceability Limit State). 

4.2 Design by Cross-Section 

 
Figure 4.2: Table 2.2 Design by Cross-Section 

In this table, the maximum design ratios are displayed for all designed members and for all 
designed load cases, load groups and combinations. The results are sorted according to 
cross-sections. For tapered members, both cross-section descriptions are shown in the line 
next to the cross-section number. 
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4.3 Design by Set of Members 

 
Figure 4.3: Table 2.3 Design by Set of Members 

This table is displayed if at least one set of members was selected for design. The maximum 
design ratios are listed according to sets of members. The number of the member with the 
highest design ratio within each set of members is shown as well. 

4.4 Design by Member 

 
Figure 4.4: Table 2.4 Design by Member 
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In this table, the maximum design ratios are arranged according to member numbers. The 
Location x at which the maximum value occurs is stated for every member. 

The description of the individual columns can be found in chapter 4.1 on page 30. 

4.5 Design by x-Location 

 
Figure 4.5: Table 2.5 Design by x-Location 

This results table lists the maximum values of every member at the following locations x ac-
cording to the division points of RSTAB: 

• Start and end nodes 

• Internal nodes according to a potential user-defined member division  

• Division points according to the number of member divisions that were set in the 
RSTAB Calculation Parameters dialog box in the Options tab 

• Extreme values of internal forces 
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4.6 Governing Internal Forces by Member 
In this table, the governing internal forces are shown which lead to the maximum design 
ratios. 

 
Figure 4.6: Table 3.1 Governing Internal Forces by Member 

Location x 
For every member, the location x on the member with the maximum design ratio is shown. 

Load Case 
In this column, the numbers of the load cases, load groups or combination whose internal 
forces have the most unfavorable effects are displayed. 

Forces / Moments 
The decisive axial and shear forces as well as the torsional and bending moments are listed 
for every member. 

Design according to Formula 
The last column includes the relevant equations that were followed in the design. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.7: Table 3.2 Governing Internal Forces by Set of Members 

In this results table, the governing internal forces that lead to the maximum design ratios of 
every set of members are shown. 

4.8 Member Slendernesses 

 
Figure 4.8: Table 3.3 Member Slendernesses 
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In table 3.3, the effective slenderness ratios of all designed members are compared with the 
maximum values that were set in the Details dialog box (see Chapter 3.1). These ratios are 
listed with respect to the major and minor principal axes. This table provides information on 
the maximum effective slenderness ratios only, it does not give any design results. 

Members of the types "Tension" or "Cable" are excluded from this table. 

4.9 Parts List by Member 

 
Figure 4.9: Table 4.1 Parts List by Member 

Finally, the parts list of all cross-sections that are considered in the given design case is dis-
played. This list contains only designed members by default. If all members of the structure 
are to be included, you can modify the setting in the Details dialog box (see Figure 3.1 on 
page 27) that can be opened via the [Details] button. 

Part No. 
The same part number is automatically assigned to identical members. 

Cross-section 
In this column, the cross-section description is displayed. 

Number of Members  
The number of identical members is given for each part. 

Length 
This column displays the unit lengths of every single member. 

Total Length  
This column represents the product of the values given in the two previous columns. 
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Surface Area  
The surface area which is related to the total length of the relevant part is calculated on the 
basis of the value ASurf of each cross-section. You can check on this value by clicking on the 
[Info about Current Cross-Section...] button in tables 1.3 or 2.1 to 2.5. 

Volume 
The volume of every part is calculated from the surface area and the total length. 

Unit Weight 
The Unit Weight of the cross-section represents the weight per length of 1 m. In case of ta-
pered cross-sections, the unit weight is calculated as the mean value of both cross-sections. 

Weight 
The value in this column is calculated as the product of values in the columns C and G. 

Total Weight 
The total weight of each part is displayed in the last column. 

Sum 
The sums of the values in the individual columns are given in the final row of the list. The 
cell Total Weight shows the total required amount of steel. 

4.10 Parts List by Set of Members 

 
Figure 4.10: Table 4.2 Parts List by Set of Members 

The last table in STEEL AISC is presented when at least one set of members was selected for 
the design. The advantage of this table is that a parts list is given for the various groups of 
elements (e.g. for a beam). 

The table columns are described in Chapter 4.9. If there are different cross-sections within 
the set of members, the mean values of surface area, volume and unit weight are listed. 
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5. Evaluation of Results 
The design results can be evaluated in different ways. For this, the buttons in the results 
tables are very useful which are located below the upper tables.  

 
Figure 5.1: Buttons for Evaluation of Results 

These buttons have the following functions:  

Button Name Function 

 
Design of Ultimate Limit 
State 

Switch on/off the design results of the ultimate 
limit state 

 
Design of Serviceability 
Limit State 

Switch on/off the design results of the serviceabi-
lity limit state 

 
Show Color Bars in Table 

Switch on/off the color background in the results 
tables according to the reference scale 

 
Show Rows with Ratio > 1 

Show only rows with the stress ratios greater than 
1 and, accordingly, the failed design 

 
Show Result Diagrams of 
Current Member  

Open the diagram Result Diagram on Member 
 Chapter 5.2, page 41 

 
Jump to Graphics to 
Change View  

Go to the RSTAB work window in order to change 
the display settings 

 

Pick Member in Graphics 
and Go to This Member in 
Table 

Click on a specific member in the RSTAB window 
whose result values are to be displayed in the 
table 

Table 5.1:  Buttons in Results Tables 2.1 to 2.5 



5  Evaluation of Results 

 39 Program STEEL AISC © 2010 by Dlubal Engineering Software 

 

 

 

 

   
   

5.1 Results on RSTAB Model 
You can use the RSTAB work window to evaluate the design results. The RSTAB graphics in 
the background can be useful if you want to check the location of a specific member in the 
model: the member that is selected in the STEEL AISC results table is also highlighted in the 
selection color in the RSTAB background graphics. Additionally, an arrow marks the mem-
ber location x which is stated as decisive in the selected line. 

 
Figure 5.2: Selection of Member and Current Location x in RSTAB Model  

If you do not get a favorable view even by moving the STEEL AISC window, you can apply 
the so-called View Mode by clicking on the [Change View] button: the STEEL AISC window 
is switched off and you can change the view on the RSTAB model. In this mode, the func-
tions from the View menu are available, e.g. zoom, move or rotate the view. 

The design ratios can be also displayed directly on the structural model. Close STEEL AISC 
via the [Graphic] button. The design ratios are then shown graphically in the RSTAB work 
window. 

Similarly to the internal forces of RSTAB, you can activate or deactivate the design results by 
the [Results on/off] button. The [Show Result Values] button controls the display of the nu-
merical values in the graphics. 

Regarding the fact that the RSTAB tables are irrelevant to evaluate the STEEL AISC results, 
you can deactivate them by using the button visible on the left. 
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A particular design case can be selected from the list of cases in the RSTAB toolbar. 

The display of the results can be also controlled by the Display navigator, using the entry 
Results → Members. The design ratio is displayed Two Colored by default. 

 
Figure 5.3: Display Navigator: Results →  Members → Two Colored 

If you select the Colored results display, the panel colors becomes available with various op-
tions for the multicolor display. Those are described in Chapter 4.4.6 of the RSTAB manual. 

 
Figure 5.4: Design ratios for Option Cross-sections in the Display Navigator 
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As for the member internal forces, you can set the scale factor for the graphics of the 
design results in the Factors tab. If you enter the factor 0 in the Member Diagrams input 
field, the design ratios will be shown with an increased line thickness. 

This graphic view can be incorporated to the global printout report (see Chapter 6.2 on 
page 44). 

You can return to STEEL AISC any time by clicking on the [STEEL AISC] button in the panel. 

5.2 Result Diagrams  
In order to view the detailed distribution of results of a specific member, the graph of re-
sults can be used. Select the relevant member or set of members in the results table of 
STEEL AISC and then activate the diagram by the button as seen to the left. This button is 
located below the upper tables of results.  

The result diagrams are available in the RSTAB window via the main menu 

  Results → Member Results 

or by using the corresponding button in the toolbar. 

A new window is opened in which the result diagrams of the selected member or set of 
members are shown. 

 
Figure 5.5: Result Diagram on Member Dialog Box 

A particular design case can be selected from the list in the toolbar.  

The Result Diagram on Member dialog box is described in detail in Chapter 9.8.4 of the 
RSTAB manual. 
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5.3 Filtering Results 
The structure of the STEEL AISC tables makes it already possible to select the results accord-
ing to certain criteria. Additionally, you can use the filter functions as described in the 
RSTAB manual to graphically evaluate the STEEL AISC results.  

Firstly, you can use already defined partial views (cf RSTAB manual, Chapter 9.8.6) that 
group certain objects in a favorable way. 

Secondly, you can set the stress ratios as criteria for filtering the results in the RSTAB work 
window. For this, the so-called control panel is to be displayed. If it is not visible, you can 
switch it on in the main menu 

View → Control panel 

or by clicking on the corresponding button in the Results toolbar. 

This panel is described in Chapter 4.4.6 of the RSTAB manual. The settings to filter the re-
sults are defined in the Color Spectrum tab of the panel. As this register is not available in 
case of the two colored stress display, it can be switched on by selecting one of the display 
options Colored or Cross-Sections in the Display navigator. 

 
Figure 5.6: Display Navigator: Results → Members → Colored 

For a colored view of the results, you can set in the panel that e.g. only design ratios great-
er than 0.30 are to be displayed. Furthermore, you can adjust the color spectrum in a way 
that one single color range exactly covers the design ratio 0.05 (see Figure 5.7). 

By the option Display hidden result diagram (Display navigator, entry Results → Members), 
you can also display design results that do not satisfy the given conditions. Those design di-
agrams will then be drawn as dashed lines. 
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Figure 5.7: Filtering of Stress Ratios with Adjusted Color Spectrum  

Filtering Members 

In the Filter tab of the control panel, you can enter the numbers of the members whose de-
sign ratios are to be shown in the graphics. This function is described in Chapter 9.8.6 of 
the RSTAB manual. 

Contrary to the partial view function, the entire structure is displayed here. The following 
figure shows the design ratios in the compressed flange of a footbridge. The other mem-
bers of this structure are also shown in the model but they are without any design ratios. 

 
Figure 5.8: Filtering Members: Design Ratios of  Footbridge Flange 
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6. Printout 
 

6.1 Printout Report 
For the design results of STEEL AISC, a printout report can be created to which you can add 
graphics and comments. In this printout report, it is also possible to select the results tables 
of STEEL AISC that are to be printed.  

The printout report is described in detail in the manual of the RSTAB program. In particular, 
Chapter 10.1.3.4 Selecting Data of Add-on Modules on page 227 is important. It deals with 
the selection of input and output data in all add-on modules. 

You can create several printout reports for every design case. For very large structures, it is 
recommended to create several smaller reports instead of a single extensive one. If you cre-
ate a specific report only for data of the STEEL AISC design case, the printout report will be 
processed fairly quickly. 

6.2 Print STEEL AISC Graphics 
It is possible to print the stress ratios displayed on the RSTAB model. All graphics can be in-
corporated to the printout report or sent directly to the printer. Chapter 10.2 of the RSTAB 
manual describes in detail how to print graphic displays. 

Results on RSTAB Model 

Every image of the RSTAB work window can be included in the printout report. The current 
STEEL AISC graphics is printed by using the main menu 

File → Print… 

or by clicking on the corresponding button in the toolbar. 

 
Figure 6.1: Print Button in Toolbar in Main Window 

Result Diagram 

You can also print the result diagrams of members by clicking on the [Print] button in the 
Result Diagram on Member window. 

 
Figure 6.2: Print Button in Toolbar of Result Diagram Window 

The following dialog box opens. 
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Figure 6.3: Graphic Printout Dialog Box, General Tab 

This dialog box is described in detail in chapter 10.2 on page 243 in the RSTAB manual. The 
remaining two tabs Options and Color Spectrum are also explained there. 

In the printout report, any image of the STEEL AISC results can be moved to a different lo-
cation by the Drag&Drop function. It is also possible to adjust inserted images subsequent-
ly: right mouse click on the relevant entry in the report navigator, then select Properties in 
the context menu. The Graphic Printout dialog box is displayed again in which the possible 
changes can be set. 

 
Figure 6.4: Graphic Printout Dialog Box, Options Tab
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7. General Functions 
This chapter describes the commonly used functions of the main menu as well as the export 
options of the design results. 

7.1 STEEL AISC Design Cases 
There is an option to group members into separate design cases. In this way, it is possible 
to design separately certain structural parts with specific parameters, for example. 

A member or set of members can be analyzed in different design cases without any prob-
lem.  

All design cases created in STEEL AISC are contained in the list of load cases and load 
groups in the toolbar in the RSTAB work window. 

Create New STEEL AISC Case 
A new design case can be created from the STEEL AISC main menu 

File → New Case… 

The following dialog box opens: 

 
Figure 7.1: New STEEL AISC-Case Dialog Box 

In this dialog box, you need to fill in the (not yet used) Number and Description of the new 
design case. After closing the dialog box with [OK], the STEEL AISC table 1.1 General Data is 
shown where you can define the new design data. 

Rename STEEL AISC Case 
The description of a design case can be changed via the STEEL AISC main menu 

File → Rename Case… 

The Rename STEEL AISC-Case dialog box is opened. 

 
Figure 7.2: Rename STEEL AISC-Case Dialog Box  
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Copy STEEL AISC Case 
The input data of the current design case can be copied via the STEEL AISC main menu 

File → Copy Case… 

The Copy STEEL AISC-Case dialog box opens. Enter the number and description of the new 
design case into which the selected case is to be copied. 

 
Figure 7.3: Copy STEEL AISC-Case Dialog Box 

Delete STEEL AISC Case 
Design cases can be deleted via the STEEL AISC main menu 

File → Delete Cases… 

In the Delete Cases dialog box, select a specific design case from the list of Available Cases. 
It will be deleted when clicking on [OK]. 

 
Figure 7.4: Delete Cases Dialog Box 
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7.2 Cross-Section Optimization 
The module STEEL AISC offers the possibility to optimize cross-sections. For this, select the 
cross-section that is to be optimized in column D resp. E of table 1.3 Cross-sections by tick-
ing the appropriate box (see Figure 2.6 on page 13). 

You can also start the optimization of a cross-section via the context menu in the results 
tables. 

During the optimization, STEEL AISC examines which cross-section within the same cross-
sections series satisfies the design “optimally“, i.e. is the closest to the maximum allowable 
design ratio which has been defined in the Details dialog box, section Cross-section Optimi-
zation (see Figure 3.1). The required cross-section properties are calculated on the basis of 
the internal forces from RSTAB. Finally, the cross-section is chosen which satisfies the design 
with the highest possible design ratio. For this reason, two cross-sections are shown graph-
ically in table 1.3 on the right – the original cross-section from RSTAB and the optimized 
one (see Figure 7.6). 

When ticking the optimization box for parameterized cross-sections from the library, the 
following dialog box appears for you to enter detailed data. 

 
Figure 7.5: Welded Cross-Sections - I-Symmetric: Optimize Dialog Box 

At first, select the parameter(s) that you want to modify in column Optimize. Hence, the 
columns Minimal and Maximal become accessible where the upper and lower limits of each 
optimization parameter can be defined. The column Increment controls in which intervals 
the parameter dimensions vary during the optimization process. 

If you want to Keep Current Side Proportions, tick the corresponding box in the lower part 
of this dialog box. Additionally, it is necessary to tick all parameters for the optimization. 

It is not possible to carry out the optimization for combined rolled cross-sections. 

Please keep in mind that during the optimization the internal forces will not be recalculated 
automatically on the basis of the modified cross-sections. It depends on the user’s decision 
when and which cross-sections are to be adapted in RSTAB for a new analysis. The internal 
forces based on the optimized cross-sections may differ considerably due to the changed 
rigidities within the structural model. Thus, we recommend recalculating the internal forces 
after one optimization run and then optimizing the cross-sections once more. 
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It is not necessary to transfer the modified cross-sections to RSTAB manually. Open table 
1.3 Cross-sections and select in the main menu 

Edit → Export All Cross-Sections to RSTAB 

The option to export the modified cross-sections to RSTAB is also contained in the context 
menu of table 1.3. 

 
Figure 7.6: Context Menu in Table 1.3 Cross-Sections 

Before the cross-sections are transferred to RSTAB, a question appears because exporting 
also implies deleting the results. If you then start the [Calculation] in STEEL AISC, the inter-
nal forces of RSTAB and the design ratios of STEEL AISC are calculated in one calculation 
run. 

 
Figure 7.7: Question before Transferring Modified Cross-Sections to RSTAB  

In a similar way, you can reload the original cross-sections from RSTAB to STEEL AISC by us-
ing the appropriate functions in the main menu or context menu. Please note that this op-
tion is only available in table 1.3 Cross-Sections. 

If you want to optimize a tapered member, the cross-sections of the member start and of 
the member end are optimized. After this, the moments of inertia are linearly interpolated 
at the intermediate locations of the member. As those are considered by the fourth power, 
the stress design may be inaccurate if there are big differences in height of the start and 
end cross-sections. In such a case, we recommend dividing tapers into several members 
whose start and end cross-sections do not show such big differences. 
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7.3 Import / Export of Materials 
If you change a material in table 1.2 of STEEL AISC, you can export it to RSTAB like cross-
sections or also reload the original material from RSTAB to the module. The materials that 
have been modified in the module are marked in blue color. 

It is not necessary to transfer the modified materials to RSTAB manually. Instead, open table 
1.2 Materials and choose in the main menu 

Edit → Export all Materials to RSTAB. 

The option to export modified materials to RSTAB is also included in the context menu of 
table 1.2. 

 
Figure 7.8: Context Menu in Table 1.2 Materials  

Before the materials are transferred to RSTAB, a question is shown because exporting also 
implies deleting the results. If you then start the [Calculation] in STEEL AISC, the internal 
forces of RSTAB and the design ratios of STEEL AISC are calculated in one calculation run. 

 
Figure 7.9: Question before Transferring Modified Materials to RSTAB  
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7.4 Units and Decimal Places 
The units and decimal places are centrally managed for RSTAB and all its add-on modules. 
In STEEL AISC, open the dialog box to set the units via the main menu 

Settings → Units and Decimal Places… 

The familiar RSTAB dialog box opens. The module STEEL AISC is already set by default. 

 
Figure 7.10: Units and Decimal Places Dialog Box 

The settings can be stored as a user profile. They can also be applied later in different cases. 
This function is described in Chapter 11.6.2 of the RSTAB manual. 

7.5 Exporting Results 
The design results can be transferred to other programs in different ways. 

Clipboard 

Select the relevant cells in the results table of STEEL AISC and copy them to the clipboard 
via [Ctrl]+[C]. The contents can then be inserted via [Ctrl]+[V] to e.g. some text processing 
program. The headers of the table columns are not exported. 

Printout Report  

The STEEL AISC data can be sent to the printout report (see Chapter 6.1, page 44) and then 
be exported via the main menu 

File → Export to RTF File or BauText… 

This function is described in Chapter 10.1.11 of the RSTAB manual on page 239. 
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Excel / OpenOffice 

STEEL AISC enables you to directly export data to MS Excel or OpenOffice.org Calc. Call up 
this function via the main menu 

File → Export Tables… 

The following dialog box opens: 

 
Figure 7.11: Export - MS Excel Dialog Box 

As soon as you have chosen the relevant options, you can start the export by [OK]. Excel or 
OpenOffice do not need to run in the background, they will be started automatically before 
the export. 

 
Figure 7.12: Results in Excel
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8. Example 
 

Column with Biaxial Bending 
In the following example, the decisive stability design of buckling and lateral buckling is 
carried out by analyzing the relevant interaction conditions. The calculation described below 
follows the Load and Resistance Factor Design provisions. 

Design Values 
Structure and Loads 

 

Figure 8.1: Structure and Design Loads (γ-fold) 

Internal Forces according to Linear Static Analysis  

             
  N My Mz Vy Vz 

Figure 8.2: Internal Forces 

w 

2 m 

2 m 

V 

P 

z 

y 

W 8x24 

Design values of static loads: 

P = 300 kN 
w = 5.0 kN/m 
V = 7.5 kN 
 
Cross-section: W 8x24 
 
Material: ASTM A36 

4 m 
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Design Location (Decisive Location x) 
The design proceeds according to locations x, i.e. on defined locations x of the equivalent 
member. The following internal forces act in the decisive location at x = 2.00 m:  

Pr = –300.00 kN      Mry = 10.00 kNm      Mrz = 7.50 kNm      Vry = 3.75 kN      Vrz = 0.00 kN 

Cross-Section Properties W 8x24, A36 

 Cross-Section Property Symbol Value  Units 

 Gross area of cross-section Ag 45.677 cm2 

 Moment of inertia Iy 3446.40 cm4 

 Moment of inertia Iz 761.70 cm4 

 Radius of inertia ry 8.687 cm 

 Radius of inertia  rz 4.089 cm 

 Cross-section weight G  35.9 kg/m 

 Moment of torsional rigidity J 14.57 cm4 

 Warping moment of inertia Cw   69550.80 cm6 

 Elastic cross-section modulus Sy  342.49 cm3 

 Elastic cross-section modulus Sz 92.26 cm3 

 Plastic cross-section modulus Zy  380.18 cm3 

 Plastic cross-section modulus Zz 140.44 cm3 

Classification of cross-section – Table B4.1 
Compression 

Flange 

Case 3 – Uniform compression in flanges of rolled I-shaped section: 

119.816.10/49.82t/b ==  

A/Np =λ  

894.152.248/19993856.0F/E56.0 yr ===λ  

Flange is NonCompact in compression. 

Web 

Case 10 – Uniform compression in web of doubly symmetric rolled I-shaped section: 

02.2522.6/7.155t/h w ==  

A/Np =λ  

29.422.248/19993849.1F/E49.1 yr ===λ  

Web is NonCompact in compression. 

The section is NonCompact in compression. 

Flexure 
Case 1 – Flexure in flanges of rolled I-shaped section: 

119.816.10/49.82t/b ==  

785.102.248/19993838.0F/E38.0 yp ===λ  

382.282.248/1999380.1F/E0.1 yr ===λ  

Flange is Compact in flexure. 
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Case 9 – Flexure in web of doubly symmetric rolled I-shaped section: 

02.2522.6/7.155t/h w ==  

717.1062.248/19993876.3F/E76.3 yp ===λ  

779.1612.248/1999387.5F/E7.5 yr ===λ  

Web is Compact in flexure. 

The section is Compact in flexure. 

Chapter E 
Buckling about Minor Axis (⊥ to z-z Axis)  

Check slenderness ratio: 

953.97
89.40

40000.1
r

LK

z

z =
⋅

=     

Check limit: 

73.133
2.248

199938.0
71.4

F
E

71.4
y

=⋅=  

Calculate the elastic critical buckling stress Fe: 

MPa665.205

89.40
40000.1

199938

r
LK

E
Fe

2

2

2

z

z

2
=







 ⋅

⋅π
=










π
=  

Calculate flexural buckling stress Fcr,z: 

Because 
yz

z
F
E

71.4
r

LK
≤  

MPa773.1492.248658.0F658.0F 665.205
2.248

y
F

F

z,cr
e

y

=⋅













=⋅
















=  

Nominal compressive strength Pn,z: 

kN12.684N1206847.4567773.149AgFP z,crz,n ==⋅=⋅=  

Design compressive strength 

kN71.61512.6849.0P z,nc =⋅=⋅φ  

Design ratio 

487.0
12.6849.0

300
P

P

z,nc

r
z =

⋅
=

⋅φ
=η   - O.K, Decisive 
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Chapter E 
Buckling about Major Axis (⊥ to y-y Axis)  

Check slenderness ratio: 

05.46
87.86

40000.1
r

LK

y

y =
⋅

=  

Check limit: 

73.133
2.248

199938.0
71.4

F
E

71.4
y

=⋅=  

 
Calculate the elastic critical buckling stress Fe: 

MPa55.930

87.86
40000.1

199938

r

LK

E
Fe 2

2

2

y

y

2
=







 ⋅

⋅π
=












π
=  

Calculate flexural buckling stress Fcr,y: 

Because 
yy

y

F
E

71.4
r

LK
≤  

MPa981.2212.248658.0F658.0F 55.930
2.248

y
F

F

y,cr
e

y

=⋅













=⋅
















=  

Nominal compressive strength Pn,y: 

kN95.1013N95001317.4567981.221AgFP y,cry,n ==⋅=⋅=  

Design compressive strength 

kN56.91295.10139.0P y,nc =⋅=⋅φ  

Design ratio 

328.0
95.10139.0

300
P

P

y,nc

r
y =

⋅
=

⋅φ
=η   - O.K 

Chapter F 
I-Shaped Member Bent about Major Axis  

Note:

1.Yielding 

 The nominal flexural strength Mn,y, shall be the lower value obtained according to 
the limit states of yielding (plastic moment) and lateral-torsional buckling. 

Calculate the nominal flexural strength Mn,y:  

kNm36.94Nmm676360943801802.248ZFMM yyy,py,n ==⋅===  

Design flexural strength 

kNm92.8436.949.0M y,nb =⋅=⋅φ  

Design ratio 

117.0
92.84

10
M

M

y,nb

y,r
y,b ==

⋅φ
=η   - O.K 
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2.Lateral-Torsional Buckling 

Note:

Calculate Cb: 

 The calculation of lateral-torsional buckling modification factor Cb is based on 
  formula F1-1. 

0.3R
M3M4M3M5.2

M5.12
C m

CBAmax

max
b ≤

+++
=  

0.30.1
5.731045.73105.2

105.12
Cb ≤⋅

⋅+⋅+⋅+⋅
⋅

=  

0.3136.1Cb ≤=  

Limiting lengths Lp and Lr: 

mm9.2039
2.248

0.199938
89.4076.1

F
E

r76.1L
y

yp =⋅⋅==  

=







++=

2
0yy

0yy
tsr Jc

hS

E

F7.0
76.60.10.1

hS
Jc

F7.0
E

r95.1L  

=








⋅
++

⋅
=

2
0yy

0yyy

wz

0.1J

hS

E

F7.0
76.60.10.1

hS
0.1J

F7.0
E

S

C.I
95.1  

⋅
⋅⋅

⋅⋅
=

2.191342490
145700

2.2487.0
199938

342490
108.695507617000

95.1
6

 

 mm9.7597
145700

2.191342490
199938

2.2487.0
76.60.10.1

2

=





 ⋅⋅
⋅++⋅  

Check limit: 

pL < LrLb ≤    - formula (F2-2)  

Calculate the nominal flexural strength Mn,y: 

( ) y,p
pr

pb
yyy,py,pby,n M

LL

LL
SF7.0MMCM ≤
























−

−
−−=  

( ) Nmm1036.94
9.20399.7597

9.20394000
3424902.2487.01036.941036.94136.1M 666

y,n ⋅≤















−
−

⋅⋅−⋅−⋅⋅=

kNm26.93Nmm1026.93M 6
y,n =⋅=  

Design flexural strength 

kNm93.8326.939.0M y,nb =⋅=⋅φ  

Design ratio 

119.0
93.83

10
M

M

y,nb

y,r
y,b ==

⋅φ
=η   - O.K, Decisive 
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I-Shaped Member Bent about Minor Axis  

Note:

1.Yielding 

 The nominal flexural strength Mn,z, shall be the lower value obtained according to 
the limit states of yielding (plastic moment) and flange local buckling. 

Calculate the nominal flexural strength Mn,z:  

zyzyz,pz,n SF6.1ZFMM ⋅≤==  

kNm86.34Nmm208857341404402.248ZF zy ==⋅=  

kNm64.36922602.2486.1SF6.1 zy =⋅⋅=⋅  

kNm86.34M z,p =  

Design flexural strength 

kNm37.3186.349.0M z,nb =⋅=⋅φ  

Design ratio 

239.0
37.31
5.7

M

M

z,nb

z,r
z,b ==

⋅φ
=η   - O.K 

2.Flange Local Buckling 

For section with compact flanges, the limit state of yielding shall apply.  

Chapter G 
Shear in the Major axis  

Note:

Calculate the nominal shear strength Vn,y:  

 The nominal shear strength Vn,y of unstiffened or stiffened webs is calculated ac-
cording to the limit states of shear yielding and shear buckling 

y,wvyy,n ACF6.0V ⋅=  

2.1kv =  

Check limit: 

yvf F/Ek10.1t/b ⋅≤  

2.34119.8 ≤  

if true 0.1Cv =  

Shear area Aw,y: 

2
ffy,w mm25.335216.1097.1642tb2A =⋅⋅=⋅=  

after 

kN22.499N22049925.33520.12.2486.0V y,n ==⋅⋅⋅=  

Design shear strength 

m/kN22.49922.4990.1V y,nv =⋅=⋅φ  

Design ratio 

007.0
22.499

75.3
V

V

y,nb

y,r
y,v ==

⋅φ
=η   - O.K 
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Chapter H 
H1. Interaction of Flexure and Compression in Doubly Symmetric Members 

 Check limit: 

2.0
P

P
P
P

y,nc

r

c

r ≥
⋅φ

=  

2.0487.0 ≥    - true, then formula (H1-1a)  

Interaction formula: 

0.1
M

M

M

M

9
8

P
P

z,c

z,r

y,c

y,r

c

r ≤









++  

0.1
M

M

M

M

9
8

P
P

z,nb

z,r

y,nb

y,r

y,nc

r ≤










⋅φ
+

⋅φ
+

⋅φ
 

0.1
86.349.0

5.7
26.939.0

10
9
8

12.6849.0
300

≤







⋅
+

⋅
+

⋅
 

 ( ) 0.1239.0119.0
9
8

487.0 ≤++  

0.1805.0 ≤   - O.K 
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